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FOR PRODUCTS PURCHASED IN UNITED STATES
SOFTWARE LICENSE AGREEMENT

GRANT OF RIGHTS
Novell, Inc. (Novell), grants you the right to use the Software in the
quantity and on the platform(s) indicated on the Proof of Purchase
form you received in your Software package. If this Software is an
upgrade from a previous version of a Novell software product, you
may use either the current or prior version of the Software, but never
both versions at the same time. This Agreement supersedes any prior
version license and governs your use of the Software.

For a single-user computer or workstation not attached to a network,
or for a network server, the Software is considered "in use" when any
portion of the Software is either loaded in memory or virtual memory
(Loaded) or stored on a hard disk or other storage device (Stored).
For single-user computers or workstations attached to a network, the
quantity of the Software "in use" is considered to be the greater of (i)
the maximum number of computers on which the Software is Loaded
at any one time, or (ii) the maximum number of computers on which
the Software is Stored.

On a multi-user computer, the quantity of the Software "in use" is
considered to be the maximum number of sessions executed at any
one time.

You may make copies of the written documentation, which
accompanies the Software, in support of your authorized use of this
Novell software product. You may also make an archival copy of the
Software for each License obtained under this Agreement.

RESTRICTIONS
You may not rent or lease the Software without the written
permission of Novell. You may not decompile, disassemble, reverse
engineer, copy, create a derivative work, or otherwise use the
Software except as stated in this Agreement. Irrespective of the
number of sets of media included with the Software, you are granted
the right to use the Software only in the quantity indicated on the
enclosed Proof of Purchase form. Certain qualifications may apply
to the purchase of this Software; when present, they are printed on
the Software package and form part of this Agreement.

HOME OR PORTABLE COMPUTER PROVISION
You are authorized to use a copy of the Software on a home or
portable computer, as long as the extra copy is never Loaded at the
same time the Software is Loaded on the primary computer on which
you use the Software. If you have licensed this Software under an
education or charitable institution pricing program, you may not
create an extra copy of the Software under this provision for use on a
home or portable computer.

LIMITED WARRANTY/LIMITATION OF LIABILITY
This Software is licensed AS IS. If for any reason you are
dissatisfied with the software, return the product package, with proof
of purchase, to your reseller within 90 days for a full refund. If any
materials or media in this package are defective, return them to
Novell within 90 days of the date of purchase, and they will be
replaced at no charge.

THESE WARRANTIES ARE IN LIEU OF ANY OTHER
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT
WILL NOVELL BE LIABLE TO YOU FOR DAMAGES,
INCLUDING ANY LOST PROFITS, LOST SAVINGS, OR
OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES
ARISING OUT OF YOUR USE OF OR INABILITY TO USE THE
SOFTWARE, EVEN IF NOVELL OR AN AUTHORIZED
NOVELL REPRESENTATIVE HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

Some jurisdictions do not allow excluding or limiting implied
warranties or limiting liability for incidental or consequential
damages, and some jurisdictions have special statutory consumer
protection provisions that may supersede this limitation of liability.
As a result, these limitations may not apply to you if prohibited by
the laws of your jurisdiction.

CUSTOMER SUPPORT
Subject always to Novell's current applications programs support
policies, Novell will attempt to answer your technical support request
concerning the Software; however, this service is offered on a
reasonable efforts basis only, and Novell may not be able to resolve
every support request. Novell supports the Software only if it is used
under conditions and on operating systems for which the Software is
designed. Current support policies may change from time to time
without notice.

GENERAL
If any provision of this Agreement is found to be unlawful, void, or
unenforceable, then that provision shall be severed from this
Agreement and will not affect the validity and enforceability of any
of the remaining provisions. This Agreement shall be governed by
the laws of the State of Utah.

U.S. GOVERNMENT RESTRICTED RIGHTS
The Software and any accompanying materials are provided with
Restricted Rights. Use, duplication, or disclosure by the Government
is subject to restrictions as set forth in subparagraph (c) (1) (ii) of The
Rights in Technical Data and Computer Software clause at DFARS
252.227-7013 or subparagraphs (c) (1) and (2) of the Commercial
Computer Software—Restricted Rights at 48 CFR 52.227-19, as
applicable. Contractor/manufacturer is Novell, Inc. at the address
below.

ANY QUESTIONS?
If you have any questions concerning the terms of this Agreement or
special programs for education or charitable organizations, please
write to WordPerfect, Novell Applications Group, Attn. Sales Center,
1555 N. Technology Way, Orem, Utah 84057-2399.



FOR PRODUCTS PURCHASED IN ALL OTHER COUNTRIES
SOFTWARE LICENSE AGREEMENT

GRANT OF RIGHTS
Novell, Inc. (Novell), grants you the right to use the Software in the
quantity and on the platform(s) indicated on the Proof of Purchase
form you received in your Software package. If this Software is an
upgrade from a previous version of a Novell software product, you
may use either the current or prior version of the Software, but never
both versions at the same time. This Agreement supersedes any prior
version license and governs your use of the Software.

For a single-user computer or workstation not attached to a network,
or for a network server, the Software is considered "in use" when any
portion of the Software is either loaded in memory or virtual memory
(Loaded) or stored on a hard disk or other storage device. For single-
user computers or workstations attached to a network, the quantity of
the Software "in use" is considered to be the greater of (i) the
maximum number of computers on which the Software is Loaded at
any one time, or (ii) the maximum number of computers on which
the Software is stored. On a multi-user computer, the quantity of the
Software "in use" is considered to be the maximum number of
sessions executed at any one time.

You may make copies of the written documentation, which
accompanies the Software, in support of your authorized use of this
Novell software product. You may also make an archival copy of the
Software for each License obtained under this Agreement.

RESTRICTIONS
You may not rent or lease the Software without the written
permission of Novell. You may not decompile, disassemble, reverse
engineer, copy, create a derivative work or otherwise use the
Software except as stated in this Agreement. Irrespective of the
number of sets of media included with the Software, you are granted
the right to use the Software only in the quantity indicated on the
enclosed Proof of Purchase form. Certain qualifications may apply
to the purchase of this Software; when present, they are printed on
the Software package and form part of this Agreement.

HOME OR PORTABLE COMPUTER PROVISION
You are authorized to use a copy of the Software on a home or
portable computer, as long as the extra copy is never Loaded at the
same time the Software is Loaded on the primary computer on which
you use the Software. If you have licensed this Software under an
education institution or charitable institution pricing program, you
may not create an extra copy of the Software under this provision for
use on a home or portable computer.

LIMITED WARRANTY/LIMITATION OF LIABILITY
This Software is licensed AS IS. If any materials or media in this
package are defective, return them within 90 days of the date of
purchase, and they will be replaced at no charge.

THESE WARRANTIES ARE IN LIEU OF ANY OTHER
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT WILL
NOVELL BE LIABLE TO YOU FOR DAMAGES, INCLUDING
ANY LOST PROFITS, LOST SAVINGS, OR OTHER
INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING
OUT OF YOUR USE OF OR INABILITY TO USE THE
SOFTWARE, EVEN IF NOVELL OR AN AUTHORIZED
NOVELL REPRESENTATIVE HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

Some jurisdictions do not allow excluding or limiting implied
warranties or limiting liability for incidental or consequential
damages, and some jurisdictions have special statutory consumer
protection provisions that may supersede this limitation. As a result,
these limitations may not apply to you if prohibited by the laws of
your jurisdiction.

CUSTOMER SUPPORT
Subject always to Novell's current applications programs support
policies, Novell will attempt to answer your technical support request
concerning the Software; however, this service is offered on a
reasonable efforts basis only, and Novell may not be able to resolve
every support request. Novell supports the Software only if it is used
under conditions and on operating systems for which the Software is
designed. Current support policies may change from time to time
without notice.

GENERAL
If any provision of this Agreement is found to be unlawful, void, or
unenforceable, then that provision shall be severed from this
Agreement and shall not affect the validity and enforceability of any
of the remaining provisions.

ANY QUESTIONS?
If you have any questions concerning the terms of this Agreement or
special programs for education or charitable organizations, please
contact your local WordPerfect office or authorized distributor, or
write to WordPerfect, Novell Applications Group, Attn. Sales Center,
1555 N. Technology Way, Orem, Utah 84057-2399 U.S.A.



FOR PRODUCTS PURCHASED IN AUSTRALIA-NEW ZEALAND
SOFTWARE LICENCE AGREEMENT

GRANT OF RIGHTS
Novell, Inc. (Novell), grants you the right to use the Software in the
quantity and on the platform(s) indicated on the Proof of Purchase
form you received in your Software package. If this Software is an
upgrade from a previous version of a Novell software product, you
may use either the current or prior version of the Software, but never
both versions at the same time. This Agreement supersedes any prior
version license and governs your use of the Software.

For a single-user computer or workstation not attached to a network,
or for a network server, the Software is considered “in use” when any
portion of the Software is either loaded in memory or virtual memory
(Loaded) or stored on a hard disk or other storage device (Stored).
For single-user computers or workstations attached to a network, the
quantity of the Software “in use” is considered to be the greater of (i)
the maximum number of computers on which the Software is Loaded
at any one time, or (ii) the maximum number of computers on which
the Software is Stored.

On a multi-user computer, the quantity of the Software “in use” is
considered to be the maximum number of sessions executed at any
one time.

You may make copies of the written documentation, which
accompanies the Software, in support of your authorised use of this
Novell software product. You may also make an archival copy of the
Software for each licence obtained under this Agreement.

RESTRICTIONS
You may not rent or lease the Software without the written
permission of Novell. You may not decompile, disassemble, reverse
engineer, copy, create a derivative work or otherwise use the
Software except as stated in this Agreement. Irrespective of the
number of sets of media included with the Software, you are granted
the right to use the Software only in the quantity indicated on the
enclosed Proof of Purchase form. Certain qualifications may apply
to the purchase of this Software; when present, they are printed on
the Software package and form part of this Agreement.

HOME OR PORTABLE COMPUTER PROVISION
You are authorised to use a copy of the Software on a home or
portable computer, provided the extra copy is never Loaded at the
same time the Software is Loaded on the primary computer on which
you use the Software. If you have licensed this Software under an
educational institution or charitable institution pricing, you may not
create an extra copy of the Software under this provision for use on a
home or portable computer.

LIMITED WARRANTY/LIMITATIONS OF LIABILITY
A. This Part A is subject to provisions of Part B which follows
below. This Software is licensed AS IS. If any materials or media in
this package are defective, please return them within 90 days of the
date of purchase, and they will be replaced free of charge.

THESE WARRANTIES ARE IN LIEU OF ANY OTHER
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT WILL
NOVELL BE LIABLE TO YOU FOR DAMAGES, INCLUDING
ANY LOST PROFITS, LOST SAVINGS, OR OTHER
INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING
OUT OF YOUR USE OF OR INABILITY TO USE THE
SOFTWARE, EVEN IF NOVELL OR AN AUTHORISED
NOVELL REPRESENTATIVE HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

B. Trade Practices Act. Where any legislation, such as the Trade
Practices Act 1974, implies into this Agreement any condition or
warranty and that legislation avoids or prohibits provisions in a
contract excluding the application of the condition or warranty, the
liability of Novell for any breach of the condition or warranty is
limited at the option of Novell to any one or more of the following:
a) if the breach relates to goods, replacing the goods or the payment
of the cost of acquiring equivalent goods or repairing the goods or
payment of the cost of repairing the goods; b) if the breach relates to
services, the supplying of the services again or the payment of the
cost of having the services supplied again.

Nothing in this Agreement is intended to restrict or exclude any
liability of Novell under Part VA of the Trade Practices Act 1974.

CUSTOMER SUPPORT
Subject always to Novell's current applications programs support
policies, Novell will attempt to answer your technical support request
concerning the Software; however, this service is offered on a
reasonable efforts basis only, and Novell may not be able to resolve
every support request. Novell supports the Software only if it is used
under conditions and on operating systems for which the Software is
designed. Current support policies may change from time to time
without notice.

GENERAL
If any provision of this Agreement is found to be unlawful, void, or
unenforceable, then that provision shall be severed from this
Agreement and shall not affect the validity and enforceability of any
of the remaining provisions.

ANY QUESTIONS?
If you have any questions concerning the terms of this Agreement or
special programmes for educational or charitable organisations,
please contact your local WordPerfect office or authorised
distributor, or write to WordPerfect, Novell Applications Group,
Attn. Sales Center, 1555 N. Technology Way, Orem, Utah 84057-
2399 U.S.A.



FOR PRODUCTS PURCHASED IN UNITED KINGDOM
SOFTWARE LICENCE AGREEMENT

GRANT OF RIGHTS
Novell, Inc. (Novell), grants you the right to use the Software in the
quantity and on the platform(s) indicated on the Proof of Purchase
form you received in your Software package. If this Software is an
upgrade from a previous version of a Novell software product, you
may use either the current or prior version of the Software, but never
both versions at the same time. This Agreement supersedes any prior
version license and governs your use of the Software.

For a single-user computer or workstation not attached to a network
or for a network server, the Software is considered "in use" when any
portion of the Software is either loaded in memory or virtual memory
(Loaded) or stored on a hard disk or other storage device (Stored).
For single-user computers or workstations attached to a network
(Network Stations), the quantity of the Software in use is considered
to be the greater of the maximum number of Network Stations that
have the Software Loaded at any one time, and the number of
Network Stations that have the Software Stored. For a multi-user
computer, a "use" is counted for every session of the Software
running on the computer.

RESTRICTIONS
You may not rent or lease the Software without the written
permission of Novell. You may not decompile, disassemble, reverse
engineer, copy, create a derivative work or otherwise use the
Software except as stated in this Agreement. Irrespective of the
number of sets of media included with the Software, you are granted
the right to use the Software only in the quantity indicated on the
enclosed Proof of Purchase form. Certain qualifications may apply
to the purchase of this Software; when present, they are printed on
the Software package and form part of this Agreement.

SPECIAL PROVISIONS
Novell grants you a special licence to place an extra copy of the
Software on a home or laptop computer, as long as the extra copy is
never loaded at the same time the Software is loaded on the primary
computer on which you use the Software. Special licensing
provisions may apply for a qualified educational or charitable
institution.

LIMITED WARRANTY/LIMITATION OF LIABILITY
If you enter into this Licence Agreement as part of a consumer
transaction: if any materials or media in this package are defective,
return them within 90 days of the original date of purchase, and
Novell will replace them at no charge. THE FOREGOING DOES
NOT AND WILL NOT AFFECT YOUR STATUTORY RIGHTS
AS A CONSUMER.

If you do not enter into this Licence Agreement as part of a consumer
transaction: THIS SOFTWARE IS LICENCED AS IS. The right to
use the Software is granted without any further warranty, condition,
representation, or other term express or implied relating to the
performance, quality, or fitness for use of the Software or written
materials accompanying the Software. Novell shall not be liable for
any loss or damage of any kind (other than personal injury or death)
arising from use of the Software or accompanying written materials
or from errors, deficiencies, or faults therein, whether such loss or
damage is caused by negligence or otherwise.

CUSTOMER SUPPORT
Subject always to Novell's current applications programs support
policies, Novell will attempt to answer your technical support request
concerning the Software; however, this service is offered on a
reasonable efforts basis only, and Novell may not be able to resolve
every support request. Novell supports the Software only if it is used

under conditions and on operating systems for which the Software is
designed. Current support policies may change from time to time
without notice.

GENERAL
If any provision of this Agreement is found to be unlawful, void, or
unenforceable, then that provision shall be severed from this
Agreement and will not affect the validity and enforceability of any
of the remaining provisions.

ANY QUESTIONS?
If you have any questions concerning the terms of this Agreement or
special programs for education or charitable organisations, please
contact your local WordPerfect office or authorised distributor, or
write to WordPerfect, Novell Applications Group, Attn. Sales Center,
1555 N. Technology Way, Orem, Utah 84057-2399 U.S.A.



FOR PRODUCTS PURCHASED IN CANADA (ENGLISH)
SOFTWARE LICENSE AGREEMENT

GRANT OF RIGHTS
Novell, Inc. (Novell), grants you the right to use the Software in the
quantity and on the platform(s) indicated on the Proof of Purchase
form you received in your Software package. If this Software is an
upgrade from a previous version of a Novell software product, you
may use either the current or prior version of the Software, but never
both versions at the same time. This Agreement supersedes any prior
version license and governs your use of the Software.

For a single-user computer or workstation not attached to a network,
or for a network server, the Software is considered "in use" when any
portion of the Software is either loaded in memory or virtual memory
(Loaded) or stored on a hard disk or other storage device (stored).
For single-user computers or workstations attached to a network, the
quantity of the Software "in use" is considered to be the greater of (i)
the maximum number of computers on which the Software is Loaded
at any one time, or (ii) the maximum number of computers on which
the Software is Stored.

On a multi-user computer, the quantity of the Software "in use" is
considered to be the maximum number of sessions executed at any
one time.

For each license obtained under this Agreement, you are authorized
to use either the Canada—English or the Canada—French version of
the software, or both, in support of a single user at any one time.
Software and documentation for both language versions may be
obtained by contacting WordPerfect, Applications Division of
Novell, Inc., at the address listed below.

You may make copies of the written documentation, which
accompanies the Software, in support of your authorized use of this
Novell software product. You may also make an archival copy of the
Software for each License obtained under this Agreement.

RESTRICTIONS
You may not rent or lease the Software without the written
permission of Novell. You may not decompile, disassemble, reverse
engineer, copy, create a derivative work, or otherwise use the
Software except as stated in this Agreement. Irrespective of the
number of sets of media included with the Software, you are granted
the right to use the Software only in the quantity indicated on the
enclosed Proof of Purchase form. Certain qualifications may apply
to the purchase of this Software; when present, they are printed on
the Software package and form part of this Agreement.

HOME OR PORTABLE COMPUTER PROVISION
You are authorized to use a copy of the Software on a home or
portable computer, as long as the extra copy is never Loaded at the
same time the Software is Loaded on the primary computer on which
you use the Software. If you have licensed this Software under an
education or charitable institution pricing program, you may not
create an extra copy of the Software under this provision for use on a
home or portable computer.

LIMITED WARRANTY/LIMITATION OF LIABILITY
This Software is licensed AS IS. If for any reason you are dissatisfied
with it, return the product package, with proof of purchase to your
reseller within 90 days of the date of purchase for a full refund. If
any materials or media in this package are defective, return them to
Novell within 90 days, and they will be replaced at no charge.

THESE WARRANTIES ARE IN LIEU OF ANY OTHER
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT WILL
NOVELL BE LIABLE TO YOU FOR DAMAGES, INCLUDING
ANY LOST PROFITS, LOST SAVINGS, OR OTHER

INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING
OUT OF YOUR USE OF OR INABILITY TO USE THE
SOFTWARE, EVEN IF NOVELL OR AN AUTHORIZED
NOVELL REPRESENTATIVE HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

Some jurisdictions do not allow excluding or limiting implied
warranties or limiting liability for incidental or consequential
damages, and some jurisdictions have special statutory consumer
protection provisions that may supersede this limitation. As a result,
these limitations may not apply to you if prohibited by the laws of
your jurisdiction.

CUSTOMER SUPPORT
Subject always to Novell's current applications programs support
policies, Novell will attempt to answer your technical support request
concerning the Software; however, this service is offered on a
reasonable efforts basis only, and Novell may not be able to resolve
every support request. Novell supports the Software only if it is used
under conditions and on operating systems for which the Software is
designed. Current support policies may change from time to time
without notice.

GENERAL
If any provision of this Agreement shall be unlawful, void, or
unenforceable, then that provision shall be deemed severed from this
Agreement and will not affect the validity and enforceability of any
of the remaining provisions.

ANY QUESTIONS?
If you have any questions concerning the terms of this Agreement or
special programs for education or charitable organizations, please
contact your local WordPerfect office or authorized distributor, or
write to WordPerfect, Novell Applications Group, Attn. Sales Center,
1555 N. Technology Way, Orem, Utah 84057-2399 U.S.A.



FOR PRODUCTS PURCHASED IN CANADA (FRANCAIS)
CONTRAT DE CONCESSION DU DROIT D'UTILISATION DES LOGICIELS

EN VERSION FRANÇAISE ACHETÉS AU CANADA

TERMES ET CONDITIONS D'UTILISATION
Novell, Inc. (Novell), vous concède le droit d'utiliser le Logiciel,
conformément au nombre de copies et à la plate-forme spécifiés par
le Formulaire de preuve d'achat inclus dans le coffret du Logiciel. Si
le Logiciel constitue une mise à jour d'un produit de WordPerfect,
Novell vous concède le droit d'utiliser la présente version ou la
version antérieure du Logiciel, mais non ces deux versions
simultanément. Le présent Contrat de concession annule ou remplace
tout contrat antérieur.

Pour les ordinateurs monopostes ou les stations de travail non
connectées à un réseau, ou pour les serveurs d'un réseau, le Logiciel
est réputé être utilisé lorsque tout ou partie du Logiciel est, soit
Chargé en mémoire virtuelle, soit Enregistré sur disque dur ou sur
toute autre forme de support. Pour les ordinateurs monopostes et les
stations de travail connectées à un réseau, le Logiciel est réputé être
utilisé sur chaque station du réseau sur laquelle le Logiciel est, soit
Chargé, soit Enregistré. Pour les ordinateurs à usage collectif, chaque
exécution du Logiciel sur l'ordinateur est réputée constituer une
utilisation du Logiciel.

Sur les ordinateurs multipostes, le Logiciel est réputé être utilisé sur
chaque station sur laquelle le logiciel est exécuté.

Toute licence, octroyée selon les termes de cet accord, autorise
l'utilisation de la version canadienne-anglaise ou de la version
canadienne-française du logiciel, ou des deux versions, par un seul
utilisateur, à tout moment. Le matériel et la documentation des deux
versions peuvent être obtenus auprès de WordPerfect, Applications
Division of Novell, Inc., à l'adresse ci-dessous.

Vous êtes autorisé à réaliser une copie de la documentation écrite
jointe au Logiciel pour lequel vous disposez d'un droit d'utilisation.
Vous êtes également autorisé à réaliser une copie de secours du
Logiciel en raison du nombre de licences d'utilisation spécifié dans
le présent Contrat.

RESTRICTIONS
Vous ne pouvez en aucun cas louer ou céder en location le Logiciel
sans l'accord écrit de Novell. Vous ne pouvez en aucun cas
décompiler, démonter, inverser, reproduire, créer une oeuvre dérivée,
ou autrement utiliser le Logiciel en dehors des cas expressément
prévus dans ce Contrat. Quel que soit le nombre de supports inclus
avec le Logiciel, vous n'êtes autorisé à utiliser que le nombre de
copies indiqué sur le Formulaire de preuve d'achat. L'achat de ce
Logiciel peut être réglementé par des conditions spéciales, imprimées
sur l'emballage contenant le Logiciel.

DISPOSITIONS RELATIVES AUX ORDINATEURS PERSONNELS ET
AUX PORTABLES
Vous êtes autorisé à utiliser une copie supplémentaire du Logiciel sur
un ordinateur personnel ou un ordinateur portable. Cette copie ne
doit en aucun cas être Chargée lorsque le Logiciel est Chargé sur
l'ordinateur principal sur lequel vous utilisez le Logiciel. Si le
logiciel est acheté dans le cadre du programme d'éducation, vous
n'êtes pas autorisé à réaliser une copie supplémentaire du logiciel
pour votre ordinateur personnel ou votre portable.

GARANTIES-LIMITATIONS DE RESPONSABILITÉS
CE LOGICIEL VOUS EST CONCÉDÉ EN LICENCE EN L'ÉTAT;
SI POUR UNE RAISON QUELCONQUE, VOUS N'ÊTES PAS
SATISFAIT, VOUS DISPOSEZ D'UN DÉLAI DE 90 JOURS, À
COMPTER DE LA DATE D'ACHAT, POUR RETOURNER LE
LOGICIEL, Y COMPRIS TOUS COMPOSANTS RELATIFS,
ACCOMPAGNÉ DU FORMULAIRE DE PREUVE D'ACHAT À
VOTRE REVENDEUR, ET VOUS SEREZ INTÉGRALEMENT

REMBOURSÉ. EN OUTRE, NOVELL S'ENGAGE À
REMPLACER GRATUITEMENT TOUTE DISQUETTE OU
ÉLÉMENT DÉFECTUEUX CONTENU DANS L'EMBALLAGE
QUI SERA RETOURNÉ DANS UN DÉLAI DE 90 JOURS, À
COMPTER DE LA DATE D'ACHAT.

TOUTE AUTRE GARANTIE, EXPRESSE OU IMPLICITE, Y
COMPRIS TOUTE GARANTIE IMPLICITE D'APTITUDE À LA
COMMERCIALISATION OU D'APTITUDE À UNE
UTILISATION PARTICULIÈRE, EST EXPRESSÉMENT
EXCLUE. EN AUCUN CAS, NOVELL NE SAURAIT ÊTRE
RESPONSABLE DES DOMMAGES DIRECTS OU INDIRECTS,
Y COMPRIS TOUTE PERTE DE PROFIT OU DE BÉNÉFICE OU
AUTRES DOMMAGES INDIRECTS OU ACCESSOIRES
CAUSÉS PAR L'UTILISATION OU L'IMPOSSIBILITÉ
D'UTILISATION DU LOGICIEL ET CE, MÊME SI NOVELL OU
L'UN DE SES REPRÉSENTANTS AGRÉÉS A ÉTÉ AVERTI DE
LA POSSIBILITÉ DE TELS DOMMAGES.

Certaines juridictions ne permettent pas l'exclusion ou la limitation
de garantie implicite ou la limitation de responsabilité pour des
dommages indirects ou accessoires. En outre, certaines juridictions
prévoient des dispositions particulières relatives à la protection du
consommateur, lesquelles pourraient remplacer les dispositions qui
précèdent. En conséquence, la limitation de responsabilité peut,
conformément à la loi en vigueur dans votre juridiction, ne pas vous
être applicable.

ASSISTANCE TECHNIQUE
Dans le cadre de sa politique d'assistance technique, Novell
s'efforcera de répondre aux questions d'ordre technique concernant
le Logiciel. Cependant, il est convenu que ce service ne constitue
qu'une obligation de moyen et que Novell ne saurait satisfaire toute
demande d'assistance. Novell ne supportera le Logiciel que dans la
mesure où celui-ci est utilisé dans les conditions et selon les
configurations matérielle et logicielle pour lesquelles il a été conçu.
Les services offerts par l'Assistance technique peuvent être altérés
sans préavis.

GÉNÉRAL
Au cas où une disposition quelconque de ce contrat serait illégale,
nulle ou non exécutoire, pour quelque raison que ce soit, cette
disposition sera réputée non écrite, et la validité et le caractère
exécutoire des autres dispositions de ce contrat n'en seront pas
affectés.

RÉPONSES À VOS QUESTIONS
Si vous avez des questions à propos de ce Contrat, ou à propos des
conditions spéciales accordées aux établissements scolaires et aux
organisations caritatives, veuillez contacter la filiale dont vous
dépendez, ou votre distributeur agréé, ou écrire à WordPerfect,
Novell Applications Group, Attn. Sales Center, 1555 N. Technology
Way, Orem, Utah 84057-2399 U.S.A., ou appelez le (800) 321-2318.
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Welcome

Welcome to WordPerfect®. WordPerfect 6.1 for Windows offers a number of new
product advancements that allow users to write better, work smarter, transition easier,
and integrate perfectly. From small, time-saving touches to revolutionary new ways of
processing documents, WordPerfect is the word processor used by more people.

Registering
WordPerfect

Before continuing, please complete the Customer Registration card and return it to
WordPerfect, the Novell Applications Group (WPGroup). That way, you’ll receive
important software and information update notices.

If you’re an upgrade user of WordPerfect, your license/serial number is found on your
original Certificate of License. Enter the number from your original Certificate of
License when prompted during installation. Once you’ve entered a license/serial
number, you can choose About WordPerfect from the Help menu to view or edit the
number.

Your license number is proof that you own a legal copy of WordPerfect. You will need
the number when you call Customer Support, and it will be required if you upgrade to
a new version of WordPerfect or order replacement disks.

If you have licensing questions, you can call Customer Registration at the following
number:

Customer Registration (801) 222-4500 (toll)

Installing WordPerfect
Recommended
System
Requirements

• Personal computer using a 386 processor
• 6M RAM or more
• Hard disk with 27M free disk space
• Windows 3.1 running in enhanced mode
• VGA graphics adapter and monitor
• Maintain 4M or more of available disk space for temporary files

Because some WordPerfect features are not accessible from the keyboard, we
recommend that you use a mouse.

Installing
WordPerfect on a
Hard Disk

To install PerfectOffice, see the installation instructions in the Up and Running guide.

Because the WordPerfect files are compressed, you must use the WordPerfect setup
program to place the files on your hard disk. You’ll follow the same steps whether
you’re installing WordPerfect for the first time or as a new (upgrade) version.

If you have questions before you install, refer to Questions and Answers about
Installing later in this section.

To install WordPerfect on your hard disk,

1 Start Windows if you’ve not already done so.

2 Insert the Install 1 disk into drive A (or drive B).

3 Choose Run from the File menu in the Windows Program Manager.

4 Type a:setup (or b:setup), then choose OK.

5 Type in your name and product license number, then choose Continue.
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6 Choose Install, choose one of the installation types, then follow the on-screen prompts
to finish installing WordPerfect. (You will be able to install to any drive you want.)

If you have questions about installing, you can choose Help in the Install windows.

We recommend a Standard installation for most users. For more information about
installation options, refer to Questions and Answers about Installing later in this section.

IMPORTANT: When you’ve finished installing the program on your hard disk, put the
original disks in a safe place. Avoid exposing them to sunlight, dust, and magnetic fields
(even televisions, telephones, and stereo speakers contain magnets).

Installing
WordPerfect on a
Network

For information about installing WordPerfect on a network, see Appendix D: Networking
WordPerfect.

Questions and
Answers about
Installing

Do I need to delete earlier versions of WordPerfect before I install?
No. A Standard installation replaces the existing copy of WPWin 6.0, wherever it is.
Existing documents, graphics, and macros will not be copied over. However, any
customizations you made to WordPerfect 6.0 will be lost when you install WordPerfect 6.1.

Which installation option should I choose?
The Standard installation is the recommended installation type for most users. The
following table shows which installation option to choose:

Installation Type Use

Standard To install WordPerfect for the first time or to install a new
(upgrade) version

Custom To customize your installation by installing only part of the
program or sets of files to directories you specify

Network To install WordPerfect for use by many users on a network
server or workstation

Minimum To install the minimum files necessary to run WordPerfect for
Windows

Options To install printer drivers, fonts, the Utilities disk, or to view
README files.

When installing WordPerfect, a prompt tells me that I don’t have enough room to
install all the WordPerfect files. What should I do?
Exit the setup program and delete unnecessary files from your hard disk to make more
disk space available. You can also choose Custom or Minimum installation.
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Several files, such as Spell Checker, Thesaurus, and sound driver files are not required to
run WordPerfect. These files can be added later using Custom installation. See Appendix
E: Program Files for a list of the files necessary to run WordPerfect.

How can I conserve disk space?
Choose Minimum installation to install only the files necessary for running WordPerfect.
This option requires a minimum of 12M of free disk space and does not install the Spell
Checker, Thesaurus, Grammatik, macros, graphics, preset Toolbars, and Help files.

You can also choose Custom installation and install the program files plus any other files
you want.

After you install, you may be able to delete some files, depending on your computer setup.
See Appendix E: Program Files to see which files you can delete.

Which directories were installed?
WordPerfect for Windows is located in two main directories: \OFFICE\SHARED\WPC20,
which includes files used in other WPGroup products, such as Spell Checker and
Thesaurus, and \OFFICE\WPWIN, which includes files specific to the WordPerfect
program. If you installed a previous version of WordPerfect 6.0 for Windows, WordPerfect
6.1 is installed over the files in those same directories.

[Illustration not shown]

Directory What it contains

GRAPHICS Clip art images that you can insert in your document.
TEMPLATE Subdirectories containing template documents.
MACROS Useful macros that are included with WordPerfect.
WPDOCS Nothing, after you install. However, this is where you may

want to save your files.

I chose Minimum as the Installation Type. Why can’t I run the Spell Checker,
Thesaurus, or Grammatik?
A Minimum installation will install only those files necessary to run WordPerfect. If you
want to install writing tools such as Spell Checker, Thesaurus, or Grammatik, choose
Custom installation, then install the files you want.

I accidentally deleted some WordPerfect files. Can I reinstall only part of
WordPerfect 6.1?
Yes. Start the WordPerfect setup program, choose Custom installation, then select those
files you want to reinstall.
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How can I remove WordPerfect 6.1 for Windows from my computer?
The setup program includes an Uninstall option, which allow you to remove WordPerfect
6.1 for Windows files from your computer. From the Program Manager in Windows,
double-click the WPWin 6.1 Setup icon. Choose Standard to remove all files that
WordPerfect installed, or choose Custom to select the files you want to remove. Files you
created or modified will not be removed.

Things You Need to Know

If you are new to WordPerfect and word processing, we suggest you begin with the
Tutorial available from the Help menu in WordPerfect.

Starting
WordPerfect for
Windows

If you haven’t already done so, start Windows, then double-click the WordPerfect icon.

WordPerfect icon

WordPerfect 6.1 for Windows offers an intuitive interface where you can customize the
Power Bar, Toolbar, status bar, keyboards, and menu bars.

Menu bar

Toolbar

Power Bar

Insertion point

Mouse pointer

Status bar

Typing area

The document window
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WordPerfect 6.1
for Windows
Terms

To remain consistent with other Windows applications, we refer to common terms,
features, and objects by their Windows names. The following table is a comparison of
WordPerfect for DOS terms that are different in WordPerfect 6.1 for Windows:

WordPerfect for DOS WordPerfect 6.1 for Windows

Block (5.1, 6.0) Select
Compose (5.1, 6.0) WP Characters
Cursor (5.1, 6.0) Insertion Point
Editing screen (5.1) Document Window
Exit (5.1, 6.0) Exit/Close
List Files (5.1) Open
Look (5.1) View
Macro Define/Execute (5.1) Macro Record/Play
Move/Copy/Retrieve (5.1) Cut/Copy/Paste
Print Preview (5.1, 6.0) Full Page View
Printer Functions (5.1, 6.0) Typesetting
Program (5.1, 6.0) Application
Retrieve (5.1, 6.0) Open or Insert File
Save (5.1) Save/Save As
Search (5.1, 6.0) Find
Setup (5.1, 6.0) Preferences
Text In/Out (5.1) Open/Save As

Using Menus WordPerfect provides both pull-down menus and QuickMenus that make it easy to find
and use program features. You can customize pull-down menus for quick access to the
features you use most often.

Pull-Down Menus
Display pull-down menus by clicking a menu name from the menu bar (such as Insert).
You can also hold down Alt and press any of the highlighted or underlined letters (such as
Alt+i for the Insert menu).

The help prompt gives

information on the highlighted

menu item.

Insert menu displayed

Shortcut key

Help prompts also appear when you position the pointer over other areas of the document
window, such as the Power Bar, Toolbar, and status bar.
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QuickMenus
QuickMenus provide easy access to specific WordPerfect features. To display a
QuickMenu, place the mouse pointer in the document window, then click the right mouse
button.

QuickMenu is displayed by

pressing the right mouse

button in the document

window.

Click the left mouse button in another area of the document window to close the menu
without selecting an option.

Using Dialog Boxes WordPerfect 6.1 for Windows dialog boxes include preview windows that show how
changes will look before they are applied to a document. You can also access Help from
any dialog box to get information about dialog box options.

The preview window shows

how changes will look before

you apply them to a

document.

To exit from a menu or dialog box without performing any action, press Esc or choose
Cancel.

Typing, Editing,
and Formatting
Hints

If you’re new to word processing, choose Tutorial from the File menu. Here are some
typing and editing tips:

• When you’re typing, do not press Enter at the end of each line. The text you type will
automatically wrap to the next line. Press Enter when you finish typing a paragraph.

• Don’t use the space bar to indent the beginning of a paragraph or to center text— the
text in your document may not align properly when you print it. To indent the first line
of a paragraph, press Tab. To center a line, choose Line from the Format menu, then
choose Center.
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• Don’t use the space bar to go to the next line. If you use the space bar to go to the
next line, those extra spaces will remain when you edit your document. As a result,
you may have gaps in your paragraphs. Instead, press Enter to go to the next line.

• Don’t use the Enter key to move to the next page. If you press Enter several times to
move to the next page, you may end up with unwanted blank lines in the middle of a
page after you edit your document. Instead, press Ctrl+Enter to start a new page.

• Take time to learn WordPerfect. It may seem tedious at first, but you’ll end up saving a
lot of time.

Using Templates Every time you create a new document, you use a template to establish all formatting and
screen settings for the document. Templates let you achieve a consistent look in your
documents. You can also tie macros, custom Toolbars, or custom menus to templates.
When you open WordPerfect, the default template is selected.

You can create your own templates or use the predefined templates that come with
WordPerfect.

When you select a template, WordPerfect automatically opens a new document window
using the selected template.

Using the Power
Bar and Toolbar

The Power Bar, a narrow horizontal strip of buttons near the top of the screen, gives you a
quick way to access features you use often. The Power Bar can be customized to suit
your needs.

Toolbar

Power Bar

When you point to a button,

WordPerfect displays its name in a

QuickTip.

Notice that a help prompt describing the feature appears across the top of the screen
when you place the pointer over an icon on the Power Bar.

The Toolbar gives you quick access to editing features. It also lets you automate the
menu items, features, executable files, macros, and other Toolbars you use most often.
You can select from one of many predefined Toolbars that are included with WordPerfect,
or you can create your own.

Printing To print a document in WordPerfect, you must first select a printer and specify which port
you are using. If a printer is not selected, or if you want to change the printer that is
currently selected, see Print: Select Printer.
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Exiting
WordPerfect

You should exit WordPerfect before you turn off your computer.

1 Choose Exit from the File menu.

2 Choose No to close any open documents without saving changes and to exit
WordPerfect.

or

Choose Yes to save changes to your document, then name the file if needed.
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A Quick Tour of WordPerfect

Go through the following Quick Tour to review word processing skills and to learn about
some of the new, time-saving features WordPerfect 6.1 for Windows offers.

HINT: If you are new to word processing, choose Tutorial from the Help menu.

Opening a
Document

WordPerfect 6.1 provides easy conversions from the WordPerfect 5.x file format. In
addition, WordPerfect 6.1 converts many other major application formats, such as
Microsoft Word 6.0 and Ami Pro 3.01. You can also convert WordPerfect 5.x macros.

To open an existing document,

1 Choose Open from the File menu.

You can use the QuickList to

access commonly used

directories.

Open As Copy option

The Open File dialog box gives you all the capabilities

of a file manager program.

The Open File dialog box lists files in the directory in which you last saved or opened a
document.

2 Select Open As Copy.

When you open a document with Open As Copy selected, the document is opened as a
read-only copy of the original file, which you can’t save over the original file. However, you
can save the document with a different name. Selecting this option removes the risk of
saving unwanted changes to a document and saves time, because you can base your new
document on something you have already created.

3 Select sample.wpd, which is located in the WPDOCS directory, then choose OK.

If you can’t find this file to open, open any document, or type a couple of paragraphs in the
document and continue.

HINT: To quickly open one of the last documents you worked on, you can choose the
document name from the bottom of the File menu.

Typing and Editing
Text

WordPerfect has added several new features that will make your work easier.

Using QuickCorrect
You can turn on QuickCorrect to automatically fix errors and improve your documents as
you type.
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1 Choose QuickCorrect from the Tools menu.

Options button

As you type, any word in the left column will be replaced with the

corresponding word in the right column.

2 Type tehn in the Replace text box, press Tab, type then in the With text box, then
choose Add Entry.

3 Add any other common typos you make, such as “canada” (“Canada”) and “bagal”
(“bagel”).

Not only can QuickCorrect fix spelling errors as you type, but it will also correct
capitalization, clean up extra spaces, put in typeset-quality quotation marks, and more.

4 Choose Options.

You can correct common

typos.
You can correct spacing

between sentences.

You can let WordPerfect correct capitalization and use double

quotes (“ ”) as you type.

5 Select or deselect any options you want, then choose OK.

6 Choose Close to return to your document.

7 At the end of the first large paragraph, type Teh solution tehn is to teach safety.

Notice that “teh” turned into “the” and “tehn” turned into “then” as you typed.

Using QuickSelect
You can select words, sentences, and paragraphs using a variety of methods.

1 To use QuickSelect, click a word, then drag to select word by word.

You can also click three times, then drag to select sentence by sentence, or you can click
four times, then drag to select paragraph by paragraph.

2 Click once in the left margin to select the nearest sentence.

If you double-click in the left margin, the nearest paragraph will be selected. If you drag
the pointer down the left margin, text will be selected one sentence at a time.
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3 Place the insertion point in the word “safety” (first paragraph) below the title.

4 Click to turn on bold.

If no text is selected when you apply an attribute, such as bold or italic, the current word is
formatted.

5 Click the right mouse button in the left margin, then choose Select Sentence.

QuickMenu

You can click in the margin with the right mouse button to display a

QuickMenu.

Dragging and Dropping Text
You can use the mouse to move or copy selected text.

1 Double-click the word “Rules” in the title at the top of the document.

2 Move the mouse pointer over the selected word, drag the insertion point to end of the
line, then release the mouse button.

You can use the mouse to drag text from one place to another.

Whenever you move text using cut and paste or drag and drop, WordPerfect 6.1 “cleans
up” the spaces, which means you don’t have to go back and manually add or delete
spaces.

A Quick Tour of WordPerfect 23



HINT: If you want to copy text, hold down the Ctrl key while you release the mouse button,
and the text will be copied instead of moved.

Using Multiple Level Undo and Redo
In order to give you the freedom to safely explore document editing and formatting options,
WordPerfect 6.1 offers you up to 300 levels of Undo and Redo.

1 Choose Undo/Redo History from the Edit menu.

You can undo any of these

actions.

You can undo multiple editing actions one at a time or several at

a time.

2 Select DragAndDrop, then choose Undo.

3 Choose Close.

Using the Toolbar Using QuickTips
If you don’t know what an icon on the Toolbar does, just place your pointer over an icon to
view a QuickTip.

1 Place your mouse pointer over on the Toolbar.

Icon description

QuickTip

Hold the pointer over an icon to see what it does.

Using Additional Toolbars
WordPerfect 6.1 offers several different Toolbars that help you get your work done. Some
of the Toolbars appear automatically when you choose a feature. For instance, when you
create a table, the Table Toolbar is displayed. Other Toolbars help you accomplish
specific tasks.
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1 Click the Toolbar with your right mouse button.

You can select a different Toolbar using the QuickMenu.

2 Choose Design Tools from the QuickMenu.

3 Experiment with some of the design tools located on the right side of the Toolbar.

4 To display the default Toolbar again, click the Toolbar with your right mouse button,
then choose 6.1 WordPerfect.

Finding and
Replacing Word
Forms

You can now search for all forms of a word, and you can even replace them with the
correct forms of another word. For example, you could find all forms of the word “speak”
(spoke, speaking) and replace them with the correct form of the word “talk” (talked,
talking).

1 Press Ctrl+Home to move the insertion point to the beginning of your document.

2 Choose Find and Replace from the Edit menu.

3 Choose Word Forms from the Type menu on the dialog box.

4 Type ride in the Find text box, press Tab, then type bike in the Replace With text box.

5 Choose Find, then choose Replace.

6 Replace the next two word forms.

7 Choose OK when all the word forms have been found, then choose Close.

Using
QuickFormat with
Auto Update

If you already use QuickFormat in WordPerfect for Windows, you know how easy it is to
“pick up” formatting from one section of text and “paint” it to other locations. Now with
WordPerfect 6.1, QuickFormat automatically ties text together so that if you make changes
in one location, all other text previously painted is automatically updated as well.

1 Select the heading “A Touch of Irony,” then choose Font from the Format menu.

2 Select a different font and size, then choose OK.

A Quick Tour of WordPerfect 25


